Mountain Dynamics Garmin GPS Maps User Guide:
CD-ROM

Thank you for purchasing this Mountain Dynamics map set for your Garmin GPS. This User Guide is designed to get
you up and running with your maps and cover the basics of operating your GPS. You don't need to be a GPS expert to
use or get the most out of your maps, although we recommend you read your GPS's owner’s manual and take some
time to learn how it works.

Mountain Dynamics publishes three series of maps:

e SnowRanger ski resort maps for North America ("SnowRanger NA")
. SnowRanger ski resort maps for Europe ("SnowRanger EU")
e  SledGPS snowmobile maps for North America ("SledGPS")

Our maps are available on memory card and on CD-ROM. includes a licensed copy of Garmin's MapSource PC software
and lets you view and manage the maps on your PC, and then transfer the maps (or portions of them) to your GPS via
its cable. If you own other MapSource compatible maps, such as Garmin Topo, you can also create combinations of
both kinds of map to send to the GPS. You also can unlock additional maps from our CD-ROM to extend your coverage.

Our maps cannot be used on GPSes that do not support map display. Examples of these are the budget Geko series
and the running-oriented Forerunner 305 (though see "Snow Days" below for how you can still track your
skiing/snowboarding activities using such a GPS; and "Sending a Route" for how you can send a rudimentary "map"
from the CD version).

Installation - MapSource CD-ROM Version
Preparing to Install

You must have an Internet connection the first time you use the Garmin MapSource software on the CD-ROM,
because the region of the map that you have purchased needs to be "unlocked" for your specific GPS. Once this has
been done you do not need Internet access to use the maps on the PC nor when you transfer them to your GPS.
Additional unlock codes are available from our website to install the maps on additional GPS units, or you can unlock
additional map regions for immediate access if you did not purchase the whole set initially.

If you already have MapSource on your PC, follow the normal install steps here, and our maps will be added to your
existing installation.

This version requires a PC running Windows (any reasonably recent version). A Mac version is not currently available.
If you have bought the CD version and only have access to Mac, and have a Garmin GPS with a memory card slot, we
recommend you contact the store or website that you bought the CD from and exchange it for the memory card
version.

Install Software on your Windows PC

e Insert the CD into your CD-ROM drive. The initial Mountain Dynamics Setup screen should appear.

e If the screen does not automatically appear, you may have “Autorun” disabled on your CD-ROM drive. To start the
installation manually:
o Press the Start button at the bottom-left of your Windows screen and choose Run...

Enter: d:\setup

Press OK

If your CD-ROM has a different drive letter than D: you will need to enter X:\setup where X: is your letter
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e  Press Next. The License Agreements page will appear.

¢ Read the agreements and indicate your acceptance by clicking on the two "I Accept" checkboxes and pressing
Next. The Setup Wizard will be shown.

e Press Next and then Install. You can also choose to install the software to an alternative location instead of the
default C:\Garmin.

e The software will be installed to your PC and the final page shown

Running MapSource for the First Time

e Double-click on the MapSource icon on your desktop, or press the Start button at the bottom-left of your
Windows screen, then All Programs, then find the Garmin group and click on MapSource.
e  MapSource will open, but the first time you run it the Locked Maps Detected dialog will be shown.



Press Unlock. The Map Product Manager will be shown:
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It you already have your unlock code (if you got it at the same time that you ordered the CD from our website for
example):
o Choose the Unlock Regions tab and press Add to get the Add Unlock Region dialog:
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o Paste or enter the unlock code, together with an optional comment (e.g. "Colorado for my Rino 130") and
press OK.

If you do not yet have your unlock code:

o Click on your product and press Unlock Online...

o This will open your web browser to the Unlock Codes page on our website.
o For SledGPS maps:

= Enter your order number and email address:
Order Status and CD-ROM Unlock
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= Click on Get Code:
CD-ROM Unlock Codes

Product Region GPS Unit ID Unlock Code
SledGPS: Great Lakes

= Enter your GPS's Unit ID, a ten digit number beginning with 3.
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You can get this from the "About" or "Version" page in its Setup feature, or you can go back to the main
screen in MapSource and choose Get Unit ID on the Utilities menu. If you use MapSource, you can then
get back to the Map Product Manager by choosing Manage Map Products on the Utilities menu. Then
choose the Unlock Regions tab and press Add to get the Add Unlock Region dialog.

= Press Get Code. Your unlock code will be calculated and shown:
CD-ROM Unlock Codes
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o For SnowRanger maps:
= Log-in to your account on our site:

Usemame
Password

Login | Cancel

This is the same account you set up when you ordered the CD
= Your purchased product should be shown:
MapSource CD-ROM Unlock Codes
You have 1
= Click on Get Code
= Enter your GPS's Unit ID, a ten digit number beginning with 3. You can get this from the "About" or
"Version" page in its Setup feature, or you can go back to the main screen in MapSource and choose Get



Unit ID on the Utilities menu. If you use MapSource, you can then get back to the Map Product
Manager by choosing Manage Map Products on the Utilities menu. Then choose the Unlock Regions
tab and press Add to get the Add Unlock Region dialog.

= Press Get Code. Your unlock code will be calculated and shown.

= Copy this to the clipboard or write it down.

e  Go back to MapSource, where the Add Unlock Region dialog should be shown. You can get back to this from the
main MapSource page by choosing Manage Map Products on the Utilities menu. Then choose the Unlock
Regions tab and press Add.

. Paste or enter the unlock code, together with an optional comment (e.g. "Great Lakes for my Vista HCx") and
press OK.

Your maps are now ready to use in MapSource.

Using Garmin MapSource

When you run MapSource for the first time you will need to "unlock" the region of the map that you have purchased.
This is covered in Running MapSource for the First Time above. Unlocking additional regions is covered below.

Viewing your Maps

e You can zoom out and see all your maps by choosing Zoom Out Region on the View menu.

e You can then zoom to a specific area of interest using the Zoom tool on the Tools menu and either clicking on it
(you zoom-in each time you right-click, zoom-out each left-click) or drawing a box around the area of interest.

e Use the Hand tool to drag the map around.

Searching

e Choose Find Places on the Find menu.
e You can choose categories and enter the first part of a name and press Find. As you click on each result the map
behind the Find Places dialog changes to show that point:
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Downloading the Maps to your GPS

e Use Zoom Out Region on the View menu to zoom out and see all your map region
e Select the Map tool on the Tools menu



e Draw a box around the entire map region. This should put all the "tiles" that the map is broken down into the
Maps pane on the left: S
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. Connect your GPS to your PC using the serial or USB cable that came with it. The first time you do this your PC
may ask you for the driver CD that came with the GPS.
e Choose Send to Device on the Transfer menu
. Choose your GPS from the list. If your GPS is not shown, check its connection and that its drivers are installed
properly (see the GPS's manual). Other non-GPS devices such as USB thumb-drives may appear in the list.
*  Make sure that the Maps box is checked. Press Send.
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e Disconnect your GPS from the PC, and check the maps are installed (see Verifying and Configuring Maps on
GPS above).

Troubleshooting

e If MapSource says that your GPS is missing the required memory, you may need a blank memory card for it.
Most Garmin models have "main memory" built into the GPS itself, and can take downloaded maps whether or not
they have a memory card inserted. Some models, such as many eTrex "x" models, do not have main memory
and must have a blank memory card installed. Of these, some come with a card in place and some do not. Blank
SD or microSD cards may be obtained easily and cheaply from your local office supply or camera store as they are
the same cards that are used in many digital cameras.

e If MapSource says that the maps have not been unlocked for your GPS, you may have entered the wrong Unit ID
into our website when you obtained your unlock code. Check your Unit ID (the 10-digit number beginning with a
3) and if necessary email our technical support to replace your unlock code.

Other MapSource Features
Planning a Route

Select the Route tool on the Tools menu

Click on the point where you would like to start a route (e.g., a lodge or a lift loading point)

Click on the point you would like to go to

The route between the points will be calculated

For SnowRanger this will usually be a route using ski lifts and trails (pistes). If the two points cannot be
connected using the trail network, or for SledGPS, a straight line is drawn between the points.

You can continue adding further points to the route by clicking. Press the Esc key to end a route.

e If you get a straight line between your starting and point and destination you may wish to manually devise a
route: click on the various intersections and turns between the start and the end that you see will get you there.

Downloading a Route

e Any route that you create can be downloaded to your GPS, either at the same time as you download a set of maps
or separately.



e Choose Send to Device on the Transfer menu, and check the Routes check-box.
e You can "follow" the route on your GPS by locating the Routes feature. This feature is not available on some nivi
models.

Downloading Routes to Non-Mapping GPS Models

e You can actually download routes to GPSes that don't support the trail maps themselves! You may, for example,
have a Garmin Forerunner sports watch, or their basic Geko 201 handheld. These models cannot display a map,
but they can display and guide you on routes. You download routes to them using the normal Send to Device
feature.

Combining with other MapSource Maps

e If you own other Garmin MapSource-based maps, such as Garmin Topo and City Navigator, you can create and
download sets that combine two or more types of map.

e  Start by selecting one product in the products dropdown list (or View | Switch to Product) and choosing map
tiles. These are added to the Maps panel on the left.

e  Switch to another product. You can now continue to add map tiles to the list, so that you have both types of map.

. Download to your GPS as usual. Note that a map download always replaces all the previously downloaded maps
on the device (this does not affect built-in ones, such as the street maps on a niivi) so you need to build this
combined list to download at one time rather than downloading each type of map separately.

e Having more than one type of map loaded onto your GPS might adversely affect route calculations. If you have
streets and ski data loaded together for example, the GPS will not know that you only want to route on the ski
trail network. See Verifying and Configuring Maps on GPS above for how to temporarily disable other types of
map data if you only want to currently use one.

Unlocking Additional Regions

e Your CD-ROM contains all the map data of its series of maps, and other regions can be unlocked online. If you
bought SledGPS Great Lakes for example, you can purchase an unlock code (at a discount) to also access the
Upper Midwest region.

. Select Manage Map Products on the Utilities menu.

e  Click on your product and press Unlock Online...

e This will take you to the same web page where you obtained your first unlock code, and after you purchase the
additional code, you install it into MapSource exactly as you did in Running MapSource for the First Time
above.

Garmin BaseCamp (SnowRanger only)

. SnowRanger maps may also be viewed and managed in Garmin's new BaseCamp software, which allows you to
view the maps in 3D on your PC.

e BaseCamp is free to Garmin owners, and available from www.garmin.com/garmin/cms/us/onthetrail/basecamp

e  After you have installed BaseCamp, the SnowRanger maps will be available immediately; no further configuration
is required, as BaseCamp picks up the map information from MapSource.

Using the Maps on your Garmin GPS

Most Garmin GPS operate in similar ways, but the appearance of the screens, and the exact names of buttons and
icons, vary. We will include examples here from three different types of GPS--an eTrex, an Oregon and a nlivi--and you
will likely find that your GPS operates much like one of the three. If your GPS is new we strongly recommend you read
the manual and "quick start" guides that came with it.

Verifying and Configuring Maps on GPS

We strongly recommend you first check the maps are on the GPS, especially before departing for your next activity.
We will do this using the map setup feature.

eTrex Mop Setup - Information

e Use the PAGE button (top of right hand side) to cycle through the display pages until Ea; ‘ba ﬁ T @ .i,
Main Menu is shown
e  Use the rocker (joystick) to select and click-on Setup
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e  This will show you the maps that are installed on your GPS, and you can use the
rocker to move up and down through the list. Your GPS probably has a "basemap" P
pre-installed, and your SnowRanger/SledGPS maps should be listed. i
e You can turn a map on and off by selecting and clicking on it to toggle the check-
mark (tick) next to it on and off. g
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Oregon

On the main menu page, press the Setup button Enabled - SnowRanger North
Press Map Amerka

Press Map Information Select Map North America

This will show you the maps that are installed on your GPS. Your GPS probably has a
"basemap" pre-installed, and your SnowRanger/SledGPS maps should be listed.

e You can turn a map on and off by pressing it, then pressing Enable or Disable.

Enabled - WW DEM Basemap

niivi

Go to the main screen

Press the Tools button (a wrench (spanner))

On some models you may now need to press the Settings button

Press the Map button

Press Map Info

This will show you the maps that are installed on your GPS. Your GPS probably has
"City Navigator" street maps preinstalled, and your SnowRanger/SledGPS maps
should be listed.

e  Make sure there is a check-mark iticki next to iour SnowRanger/SledGPS trail map.

m SledGPS
[1] National

[ city Navigator North America NT 2009
(1] ALL

[] city Navigator Europe NT 2009
[1] ALL
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e  While using your new trail maps, you may wish to temporarily disable the street maps to reduce clutter.
To disable them, simply remove the check-marks from next them.
Likewise, to re-enable them, put the check-marks back.

e  Press Back until you are back at the main screen

. When you wish to use your GPS as a street navigator again, follow these same steps, but remove the check mark
from our maps and check the other map(s).

Troubleshooting

e If the maps are not shown in the list then your GPS does not believe they are loaded.

e Repeat the download paying attention to the information in any dialog boxes or error messages. In particular,
make sure during the download that the right device is selected, since other non-GPS devices such as USB thumb-
drives may appear in the list.

Viewing the Maps

The maps are shown on the main map page of your GPS, just like any other map you might have loaded. You can pan
(scroll) the map (using the touchscreen or the rocker button depending on the model), zoom in and out, click-on
features to get their names if they are not shown on the screen, and so on.
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As you zoom in and out different levels of detail are shown, so that the screen does not become too cluttered. You can
also adjust the amount of detail shown in the Detail setting in the Map Setup feature of your GPS. This is normally set
to "normal" or "medium" but can be increased or decreased.

Since your GPS will normally center the map display on your current or last-known position, you might find it difficult to
pan to the areas covered by your SnowRanger/SledGPS trail map if you are not currently "on" them. In the next
section, Using Find/Where To, we show you how to find a feature that is on the map so that you can view the maps
around it. We strongly encourage you to view the maps before you depart for your next activity to familiarize yourself
with them.

Using Find/Where To

The search function on a Garmin GPS is called Find or Where To? and allows you to find "points of interest" (POIs)
such as restaurants, chairlifts, and gas stations. As well as being essential when out doing your activity, this feature
lets you more easily browse the maps even when you are not "on" them.

eTrex
. Use the PAGE button (top of right hand side) to cycle through the display pages until Main Menu is shown
e Use the rocker (joystick) to select and click-on Find
e As a shortcut, you can also get to the Find page by pressing and holding the Menu button on the left hand side of
the eTrex.

Oregon
e On the main menu page, press the Where To? button

niivi
. Go to the main screen
. Press the Where To? button

POls are divided into categories, although you can choose All POI and search all categories together. In this example
we'll use Food and Drink. Your GPS will only show results that are within a few hundred miles/km of your current

position.
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Instead of searching near this current position, you can change the search to be relative to another location. This
might be a place you are planning on traveling too, and this also is a good way to view the maps when they are new to
get familiar with them before you start your next activity.

eTrex

e On the search results page, press the Menu button on the left hand side of the eTrex (just a normal press, not a
press-and-hold) and then choose Change Reference from the menu.

e A map page will be shown where you can pan (using the rocker) and zoom (using the normal zoom in/out buttons
on the left hand side of the eTrex) to find a city or area that you know is on or near the coverage area of your
maps. Then click with the rocker to indicate the point you would like to search from.

e The results page should now show those search results.

Oregon

e Use the Back button (arrow in bottom-left corner) to go to Search page. At the bottom of this, press the
Proximity button that looks like a target of concentric circles.

. Press A Map Point

e A map page will be shown where you can pan and zoom to find a city or area that you know is on or near the
coverage area of your maps. Then press Use.

e This will again show the main Search page again, but all searches will now be relative to the chosen spot, not your
current position.

niivi
e Use the Back button to go back to the categories screen. At the bottom of this, press the Near... button



e Press A Different City.

e Enter the name of a city that you know is on or near the coverage area of your maps.

e  This will again show the main Search page again, but all searches will now be relative to the chosen spot, not your
current position.

e Choose Food again. The results page should now show search results.

For any of the search results you can select and click-on it. Then click on the on-screen Map button (or just tap the
results button itself on a Oregon) to view the map centered on this POI.
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You can pan and scroll the map to explore it. To return to the search results, press the Page button on the right hand
side of the eTrex. You also can click on a point on the map to get more information about it.

The Go To button for a POI will give you directions from your current location to it. See Turn-by-Turn Directions
below.

Turn-by-Turn Directions (SnowRanger only)

SnowRanger NA and EU maps offer turn-by-turn directions for on-mountain navigation. This is just like the directions
feature that vehicle "sat navs" offer, indeed we use this capability built into most GPSes by making our trail maps act
like street networks. Since we are using the feature as-is, there are a number of caveats and commonsense issue that
you should bear in mind.

Most Garmin GPSes support this feature, even the "outdoors" models like the eTrex series. On vehicle type units such
as the nuvi, the directions will be spoken, and you can be skiing along listening to directions in an earpiece if you
connect one to the GPS! For outdoors units the directions are shown on-screen, and the unit will usually "beep" to
announce that the directions displayed have changed.

To start using the directions, do a Find/Where To as above, and choose "Go To" for the POI you want to get to. Your
GPS might ask you if you want to Follow Road or go Off Road. Somewhat counter-intuitively, you should select
Follow Road: remember that we are "tricking" the GPS into treating the trail maps as a street map. If you choose Off
Road it would just show a simple "as the crow flies" direction line to the destination. You also can set this behavior on
the Navigation page in Setup.

Your GPS will now show you directions as you move towards the destination.
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It will recalculate the route automatically if you miss a turn.



As we've said already, it's essential to bear in mind that we are using the standard street navigation feature of the GPS,
and do not have precise control over how it works. We ask that you use common sense when reviewing directions
given and bear in mind the following points:

e The GPS does not know what level of skier/snowboarder you are. We've arranged our map data so it will tend to
direct you on green and blue trails (pistes), but it might try to send you on a red or black trail if it cannot find a
better route. Conversely, it might send you on quite a long, safe, green route, while you would prefer to take
some shortcuts along the way down runs (pistes) that you know are within your abilities.

e The GPS treats most of the lifts and trails as "one-way streets". This makes sense, as you nearly always go
"down" trails and "up" lifts (with some lifts, such as gondolas, being two-way). If you are at a trail junction, or at
the top of a lift where multiple trails go off in different directions, the GPS may think that you already "on" the
nearest trail and committed to going down it, even though the best route is actually for you to walk a few seconds
towards another trail.

e Lifts and trails might be currently closed, especially near the beginning and end of the season.

e Sometimes you might be told to turn left when actually you need to turn right (or vice versa)! This may happen
when you are approaching the bottom of a lift that you are to get on, for example. If the trail on our map
approaches on the right side of the lift station you will be told to turn left onto the lift. However you might be
skiing along the left hand side of the trail, coming more to the left of the station, and so for you it's to your right!
It also may occur based on where the ski resort arranges the entrance for the lanes for waiting to load the lift.
The key message here is to pay more attention to the name of the lift or trail that you are being directed to,
rather than it being left or right when you are getting close to it.

. If you start a new route while you are standing on the slopes under or near the path of a lift, the route might start
by putting you on to the lift. The GPS does not know that you cannot just jump onto the lift in the middle.

e If the GPS cannot create a proper route from here to there, it will show a simple "as the crow flies" straight line to
guide you towards your destination.

We feel we've done our best to implement this feature in the framework of the built-in Garmin routing system, and
hope that you will allow us some tolerance of these issues. Consider the turn-by-turn directions more of a "suggestion"
that the definitive routing you might get in your car.

Feature Types

SnowRanger shows trails according to their color code (green, blue, black, and, in Europe, red). Major trails are drawn
with a thicker line, and appear sooner as you zoom in. Lifts are red with a black border.

SledGPS snowmobile trails are gray with a blue border.

Tips for using your GPS while skiing/snowboarding

e Keep your GPS in your pocket rather than clipped to the outside of your jacket or hanging around your neck on a
lanyard. It'll stay warmer, leading to better battery life and screen update speed, and so long as stow it with the
face away from your body you find you'll get a pretty good GPS signal.

e It's still a good idea to attach a lanyard though, as an added precaution against dropping it when wearing gloves.

e Garmin GPS screens do not need to be touched with bare skin the way that an iPhone screen does. They use a
different technology, and a raised seam on your ski glove's finger might be an excellent "stylus" to touch with.

e You may need to "lock" the screen on a touch-screen unit before you put it into your pocket.

e If your GPS uses AA/AAA batteries, NiMh rechargeables get excellent battery life for hundreds of charge cycles.
For very cold conditions, lithium batteries work best, but are expensive and not rechargeable.

e If you are using a nlvi, bear in mind that it is not as rugged as other GPSes. Nevertheless it is fairly robust--just
treat it like you would a phone or MP3 player, keeping it dry and fairly warm.

e  Some nlivi models, particularly more recent wide-screen models, can only get 2 or 3 hours of continuous use
between charges. Get in the habit of turning them off when you don't need them for active navigation.

e Record your GPS track during the day and upload it to our free Snow Days service (see below) to easily keep track
of your days skied, number of runs, vertical feet/m, etc., throughout the season.

Tips for using your GPS while snowmobiling

e See the skiing tips above for comments that apply to snowmobiling also.



e If your sled has a 12V DC outlet, consider hooking your GPS up to it so that it is not running on batteries. Not
only will this give you indefinite battery life, but by operating the GPS with the screen and backlight turned on all
the time, the GPS will stay a lot warmer.

e Rugged mounts for mounting your GPS on the handlebars or dashboard of your snowmobile are available from:
o www.ram-mounts.com
o www.touratech-usa.com

Snow Days - Track, View and Share your Skiing

Snow Days is our free GPS tracking and statistics site where you can view and share your GPS ski tracks overlaid on
top of our SnowRanger trail maps. While you are out skiing or snowboarding with your GPS it records a "breadcrumb"
track of where you go, including your elevation. When you get back to your computer you can upload this track to our
website and view where you went, and see your GPS performance statistics such a vertical feet skied, average and
maximum speeds, and miles covered. You can also share them (if you want) with the rest of our website community
and through Facebook.

You don't need to have SnowRanger maps loaded onto your GPS to use this service. It works very well with Garmin's
Forerunner GPS sports watches, and even with any non-Garmin GPS that can save its tracks to the standard GPX file
format.

See www.mountaindynamics.com/en/SnowDays.html

Other Information and Resources

If you cannot find the manual or "quick start" guide for your GPS they are available in PDF format from Garmin's
website at www.garmin.com by clicking on Manuals in the Quick Links panel on the product page for your GPS.

SnowRanger North America and Europe

www.mountaindynamics.com
support@mountaindynamics.com

SledGPS

www.sledgps.com
support@sledgps.com

Garmin MapSource

In nearly all cases you should direct support inquiries regarding the CD-ROM version of our products to us. Further
information on MapSource is however available at
www.garmin.com/garmin/cms/lang/en/us/maps/tripplanningsoftware/mapsource
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